Necessary files to install Tool-chain for ACTEL MP7
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Start by installing Libero IDE
Unzip LiberolDES80.zip and run the exe file



Install Libero Gold License
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InstallShield Wizard

() Libera Platinum or Eval Licenze

Libero

(O Desigrer Gold, Platinurn, or Eval License Integrated Design Environment

(") Gote Libero IDE website

Mest > | | Cancel

Click NEXT for several times and wait to complete the installation of LIBERO.

You were been asked to choose way of installing the license at the end of installation.

You have to visit actel website before the installation to request license.dat file for LIBERO
IDE. This file could be downloaded from actel website or from your mailbox after requesting
the LIBERO GOLD LICENCE (1 year license for using up to 1.000.000 gates). Copy this file
into C:\flexlm\licence.dat. In following window choose:



Actel Libero IDE 8.0

Licenzing Requirements

@ | already ha
Q¥ || need ko apply far a licens
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And reboot your computer.



Actel Libero IDE 8.0

Install5 hield Wizard Complete
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Open the System Properties Window by right-click on My Computer. Select the Advanced
tab and click on the Environment Variables:



System Properties
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Create new variables: LM_LICENCE FILE and SYNPLICITY LICENSE FILE with
C:\flexlm\License.dat file path. File License.dat is also necessary to copy into folder:
Libero/Desinger/adm/



Environment Variables

I=er variables For DSP

Yariable Walue
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Install the SP3 service pack for Libero 8.0 by executing LiberoIDEv80SP3.exe file. Click
NEXT for several times.

Continue with installing the CoreConsole: CoreConsole v14.exe
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Click NEXT for several times to complete the installation
You will be asked about licences again:

9P CaorelConsale requires a license in order ka run,
x.._"/

Do wou wankt ko wisit the Actel License & Registration website now to obtain a license?

| tes | [ Mo ]

So, if you have not a license, visit ACTEL’s website and request for it.
Received license rename to cclicense.dat and copy into C:\flexlm\

And into LM_LICENCE _FILE path in Envirionment variables.

Last stage for MP7 designing is the SofConsole. Run its installation by executing:
SoftConsole v2 0 setup.exe



The alternate option of ARM software development toolkit is KEIL uVision3 IDE with
RealView compiler (in demo-version up to 16kB of code) or free GNU GCC by
CodeSourcery. CodeSourcery compiler is used in softconsole too, so we will make
interconnection between KEIL uVision IDE and GNU GCC compiler. At first run installation
of uVision3 by executing: mdk311.exe. Click several times NEXT for success installation of
KEIL.

Now we prepare interconnection between KEIL and CodeSourcery GNU GCC from the
SoftConsole installation by following instructions in GLUE/readme.txt
At first copy all files instead readme.txt from GLUE folder into BIN folder of Sourcery G++:
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At the second, run KEIL. Close opened project. From toolbar menu choose Project -~ Manage
-> Components, Environments, Books...

In Folders/Extensions tab check Use GNU Compiler

In GNU-Tool-Prefix insert arm-glue-

And browse location of GNUARM folder of CodeSourecry GNU GCC in Cygnus Folder.
Click OK.



Components, Environment and Books

Folders/E stenzions l

Development Tool Folders

r

Default File Estenzions:

C Source:

Tool Baze Folder: |

e C++ Source:

Azm Source:

Object:

Library:

Select ARM Development Tools

Document:
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Close the Keil.

INSTALING DRIVERS FOR FLASHPRO3

Execute FlashProv60SP3.exe. Click NEXT and OK for several times. You will prompted to

restart the PC.




Actel FlashPro v6.0 SP3 Setup

Install5 hield Wizard Complete

L

s

v =

Irsbal Bl I < Back ﬁ Finizh 1 Cancel }

Restart it.

After restart connect your FlashPro3 into USB.



Found New Hardware Wizard

Walcome to the Found New
Hardware Wizard

Wwindows will search for current and updated software by
laaking on vaur computer, on the hardware installation CO, ar an
the ‘windows Update web site [with pour permizzion).

Fead our privacy policy

Can Windows connect to Windows Update to search for
zoftware?

() Yes, this time only

() ¥es. now and gvery time | connect a device

Click Mest to continue.

MHest » l[ Cancel

Found New Hardware Wizard

Thiz wizard helps you install software Faor;

Actel FlashProd Firmware Loader

3;'\.1 If your hardware came with an installation CD

i or Hoppy disk. insert it now.

“What do you want the wizard to do?

(®irstall the sofbware automatically [Recommendedf

() Invstall Fram a list or zpecific lacation [Advanced)

Click Mest to continue.

< Back ” Hemt » ][ Cancel




Files Needed X
i.:j, The file 'fp3bload. zys' on [Unknown] iz needed.
g

Type the path where the file iz located, and then click
QK.

Copy files from:

les_Embedded\ACTEL\FlashPra v6.0 SP3Drivers v | [ Browse.. |

Found New Hardware Wizard

Please wait while the wizard installs the software.

% Actel FlashPro3 Firmware Loader

Py = -
Cyllzh. zuz
To C:vwfNDOW Shepstem32A\DRIVERS




Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for;

% Actel FlashPro3 Firmware Loader

Click Finish to close the wizard.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will zearch for current and updated zofbware by
looking on vour computer, on the hardware installation CO, or an
the Windows [ pdate "Web site [with your permizzion).

Bead our privacy policy

Can Windows connect to Windows pdate to search for
software?

() Yes, this time only
(") Y'es, now and gvery time | connect a device

Click Mest to continue.

Hext » I [ Cancel




Found New Hardware Wizard

Thiz wizard helpz you install software for;

Actel FlazhPro3 Programmer

{ } If your hardware came with an installation CD

2 or Hoppy disk. inzert it now.

“What do you want the wizard to da?

{#)install the software automatically [Fecommended}

() Install Fram a list or specific location [Advanced)

Click Mest to continue.

< Back ” MHest » l[ Cancel

Now is your FlashPro3 ready to use.

CREATING THE NEW PROJECT WITH CORE MP7
Run Libero IDE: start -> program files -> Actel Libero IDE v8.0 -> Project manager

Create new project -> Project -> New Project



New Project Wizard

Welcome to the New Project Wizard

Thiz wizard creates a new Libero project.

B start

Praject name: |MF'?_T Likarial

Select Device

.
A

Select Tools
Al Files Project location: ||::"«.f-‘-.|:te|pr|"-.MF'?_TutDrlal
il Preferred HDL type:

" ‘erlog

f« WHOL

Browse. ..

Help

X

Cancel

Click NEXT

Mew Project Wizand

2

Ztart

Family, Die and Package

Famnily:

B Select Device

Zelect Toolz

Select the Family, die and package of your new project.

Help

¢ Back | Mewt » |

Dhie: FPackange:
Add Files AFS030 208 POFP

AFS250 206 FRGA
Finizh AFSEO0

MI1AFSEON

AFS1500

Finizh

Cancel

X|

Make same selections and click NEXT:




New Project Wizard

Select Integrated Tools
a Select the tools you want bo uze with your new project.

X

et =I--{ Core Configurator

- Add

Select Device
B select Tools
Add Files

Firizh

& T CoreConzole
T CoreConzole_1
= Synthesiz
@®  Suynplify
O T Synplify_1
= Simulation
®  ModelSim
O T ModelSim_1
= Stimuluz

o P

¢ Back | MHext » | Finizh

L

Restore Defaultz

Help

Cancel |

Select Tools, but, there is a question mark by Core Console after a new installation. So,

Double click onto CoreConsole:

Edit Profile

M ame: ||:|:|re|:|:|nsu:ule
Select a tool inteqration: | {BE = gl 2 We ksl =L
Werzion:
Frocess
Location: T |cnreu:u:unsu:ule.e:-:e

Browsze...

Additional parameters: |

Festore Defaultz | Help |

o]

Cancel |

And browse location of coreconsole.exe: ...\CoreConsole v1.4\bin\CoreConsole.exe, click
OK. In New Project Wizard click NEXT and NEXT once again and FINISH.

Import Top.vhd, that is vhdl file of top entity, where are two entities: MP7 processor and
prescaler. Global clock of FUSION is 50MHz, whilst max frequency for MP7 is only 20MHz.
We make 12.5MHz clock for MP7 by dividing the global clock by 4. So you can import
Top.vhd by: File -> Import Files... Browse the Top.vhd
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The Workshop_ 1 project was opened.

- The Workshop 1 project was closed.
Project Manager New FBatules@ The MP?_TutoElal project was created.
Reading file 'Top.wvhd'.
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Ready YHDL FAM: Fusion |DIE: M7AFS600 |PRG: 454 FEGA




In opened Window make next selections:

Divided and Delayed Clock : Create Core

Input clock source: Divider: oukbput delay;

— - jnooons  v|——>a

i [E cbernal 10

o o] rv
Generate. .. | Reset |
Help Close

And click Generate button. Enter name of component CLK _div4.

Generate Core r}_<|

Configured cores:

Core name: | CLE_divd

Cukbput Format: | J

Additional output;

[v Resource report

Help | Ik | Cancel

And click OK.



Be sure that a question mark infront of CLK div4 in Design Explorer were changed into
smartgen icon:

e Project Manager - C:\Actelprj\MP¥_Tutorial\MP¥_Tutori... E@E|
3 Project File Edit Wew Tools ‘Window Help - g x

REED=
o T
Current Designer view: |Im|:u|1 ﬂ {9 @
Design Explorer L o+~ X
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E
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o
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Continue by creating your MP7 core. In Design Flow window click on the Core Console in
Design Entry Tools section. In opened window enter name of component: ARM7 ESC



New E'
SelcctaE
Schematic
SrartDesign Companent M arne:

CoreConsole Component
IP Component ||
YHOL Source File

Yerilog Source File

Skirnulus

Skirulus HOL File

SO File {sdc)

Phesical Design Constraint File {pdc)

WD File {wed)

SAIF File {saif)

YHOL Template

Yerilog Template

Help k. | Cancel

And click OK and the CoreConsole will be opened.

€ CoreConsola - ARM7_ESC
File View Actions Options Help

Components | iSenerate -

Selected Companent's Details

CoreMP7 3

Actel's CoreMP7 is a soft [P version of the
popular ARMZTDMI-S that has been optimized to
maximize speed and minimize size in Actel's
Flash-based FPGAs. CoreMP7? is well suited for
use in a number of applications, including digital
cameras, kitchen appliances, automotive traction
control systems, car infotainment systems,
robotics and medical equipment. Actel's
e e e

P AP

b

<
<
<
Caompanents available For selection
Listked: 40 of a takal of 40 components
Processors, Actel e’
Coreg051s rslE
CoreABC
CareMPF
CortexM1 ,:M@
Bus Interfaces, Actel
Coredzd |r-'\zs@
F— b
o bt 2
< ?

Choose the CoreMP7 from list Processors, Actel in the left side of your screen and click Add
button. From Bus Interfaces, Actel list choose: CoreMP7Brigde, CoreAHB2APB and two
buses: CoreAHBLite and CoreAPB. From Peripherals, Actel choose: CoreAhbNvm,
CoreApbSram, CoreAl, CoreTimer and CoreUARTapb twice.



By Drag&Drop arange the components in next order:

ieve  Actions  Options  Help

; Components | Generate 1

Selected Companent's Details

CarelMP?

>

Core8051s

Top Level

8051 processor core with APB master interface
CoreB051s is a small, general-purpose
processor. This processor is compatible with the
instruction set of the 8057 microcontroller and CoreMP7Eridge Corehbhvm CorefhbSram
preserves the three distinct software memory
spaces so that it may be targeted by existing
8051 C cormpilers. To make it smaller and more
flexible than the 8051, however, some of the

N TR SN -
Wersion [z 3 100 v zeofz ACDFEAHBLWE

Components avalable for selection

Listed: 40 of a total of 40 components

~

A

CorefHEZAPE

Processors, Actel

CoredPE

CorefBC )
CoreMP7

CartexM1

[ile=l

e

Bus Interfaces, Actel Corenl CorellARTapb CorelJARTapb_01
Cored29 s
CoreAHE
CorsAHEZAPE
CorefHELite
CoredPE

LIcES:

[ile=l

£3

|~
v

It is necessaty to interconnect the peripherals, core and buses. I is very easy with Auto - Stitch
function: Actions -> Auto Stitch...



Set APB Masters & Slaves as folows:

Auto Stitching

2 (x

AHE:Masters

APE:Masters
CoresHEZAPE_00: APEmaster

AHE: Slaves
CorefhbMyrn_00: AHBslave
| AHEmslay el w |

Coredhbsram_00:AHEs ave

| AHBmslayel A |

CorefsHBZAPE_00: AHBslave

| AHEmslavelz W |
APE:Slaves

Corenl_00:APEslave

| APBmslavel W |

CorelJaRTapb_00:APBslave
| APBmslave3 w |

CorelAaRTapbh_01:APBslave

| APEmslaves

(£

[Select .ﬁ.ll,l'l"-.luzunel [ Stikch l [ Zancel ]

And be sure that all boxes are checked. Click Stitch.
To connect other signals with top level entity apply following steps:

Move your mouse cursor over CoreMP7bridge, four icons will show. Click on the leftmost
CONNECT icon.

Opened window fill in following way and click CONNECT:



Canneckion

_ Top Level
Connection Label: ||_|J-|-,q|5| vl
From: | CoreMP7Eridge_00 w |
From Pin{s): |L|JTAG vl
. |T-:-p Level vl The Top Level bar groups together all of the ports present at the
' subsystem top leval,
To Pinis):

Caonnections between the pins of subsystem components and
the top level may be made using connection labels.

A

Mot currently connected.

Cancel

And once again for RV_ICE _If:

Connect fz|
Connection

_ Top Level
Cannection Label: | RY_ICE_IF & |
Fraom: | CoreMP7Eridge_00 w |
From Pinfs): |RV_ICE_IF 3 |

T |T0p Level vl The Top Level bar groups together all of the parts present at the
' subsystem top level.
To Pinis):

Connections between the pins of subsysterm components and
the top level may be made using connection labels.

LY

Mot currently connected.

It was made UJITAG (debuging by FlashPro3 Interface) and RV_ICE _If interconection with
top level entity by last two steps.

Move your mouse over both CoreUARTapb, click right button on the mouse and choose
CHANGE VERSION. Choose 1.2 version instead 3.1.105 for both CoreUARTapb.

Apply an auto-stitch function again.



Move mouse button over CoretUARTapb which is configured as APBslave3 and click on the
leftmost CONNECT buton.

Fill window as follows:

Connect fz|
Connection T L I
O eve
Connection Label: | RS232_RX vl p
From: | Corel AR Tapb_00
Frar Pinfs): |rx vl
T |T0p Level "l The Top Level bar groups together all of the ports present at the
' subsystem top level.
To Pinis):
Connections between the pins of subsysterm components and ¢
the top level may be made using connection labels. 2
Mot currently connected.
Disconnect
o
Click Connect button.
And for TX line:
Connection T L I
Connection Label: Op eve
Fraom: |CoreUARTapb_ElD vl
From Pinfs): |tx vl
T |TD Level vl The Top Level bar groups together all of the parts present at the
P LR subsystem top level.
To Pinis):
Connections between the pins of subsysterm components and ¢
= the top level may be made using connection labels. 2
Connection Ok, =
Taop Level: and CarelJARTapb_00:tx are B
connected.
b

Click OK.



Move mouse button over CoretUARTapb which is configured as APBslave5 and click on the

leftmost CONNECT buton.

Fill window as follows:

Connect
Canneckion
Connection Label: | A3PUART R I |
From: | CorelJARTapb_01 A |
From Pins): |rx & |
To: |Tnp Level v |
To Pinis):

3

Mot currently connected.

o o]

Disconneck

Top Level

The Top Level bar groups together all of the ports present at the
subsystern top level.

Caonnections between the pins of subsystem components and
the top level may be made using connection labels.

A

Click OK.
For TX line:
Connect
Conneckion
Connection Label: |,q3p|_|,qRT_T>< vl
From: |CoreU.0.RTapb_E|1 vl
From Pinfs): |tx vl
Ta |T0p Level v|
To Pinis):

]

Mot currently connected.

Disconneck

Top Level

The Top Level bar groups together all of the parts present at the
subsystern top level.

Connections between the pins of subsysterm components and
the top level may be made using connection labels.

LY




All interconnections are done for purpose of this tutorial.

Some of CoreXYZ bocks allow to configure its properties.
Move mouse cursor over CoreMP7 and click second icon — configure. Make sure of Debug is
Enabled. Click OK.

Configuring CoreMP7_00

Configuration

Component Mame:  CoreMP?_00

Die: t:j

Debug: | Enabled e

P
£

Speed grade:

CoreMPF_00; (Mew Conneckion) Ay any

CoreMP?_00MPT _SywsIf CoreMP7Eridge_00:MPT _SysIf

1]

[ oK d [ Cancel

Move mouse cursor over CoreMP7Bridge and click second icon — configure. Make sure of
Debug is RealView or FlashPro3. Click OK



Configuring CoreMP 7Bridge_00

Configuration

Synchronize nIRG:
Synchronize nFIQ:

Device Family;

CoreMP7EBridge_00: {Mew Connection)
CoreMP7Eridge_00: AHBmasker
CoreMP7Eridge_00:MP7_SysIf

CoreMP7Eridae_00:ITAG
CoreMP7Eridge_00:RY_TCE_IF
CoreMP7Eridge_00:HRESETR

CoreMP7Eridge_00:HRESETR

=
(=]

=
(=]

Component Mame:  CorefMP7Eridge_00

Caonneck

TG +

L)

Debud: | pealview or FlashPros H

W

W
W
Anyiany
CorefHEBLike_00: AHBmmasker
CoreMP7_00:MPT _SysIf
Top Level;
Top Level:
CorefHELice_O0HRESETR

CoreAHEZAPE_00:HRESETR

| ok

||

i1
il
3
a
L

In the same way set Amount Of Internal Flash Required at 256kBytes in CoreAhbNvm.

Amount of internal SRAM required set on 10kBytes in CoreAhbSram.

Click the Configure icon for the CoreAl component. Set the following in the Configuring CoreAl_00

dialog box. Accept the default settings for all other options and click OK:

= ATO input:
= AT3input:
=  AT4 input:
= ACSinput:
= AT6 input:

= AG6 output:

= AG7 output;

= AT8input:

= AGS output:

= ADC MODE control:

= ADC MODE fixed value:
= TVCJ7:0] pins control:

=  TVC[7:0] fixed value:

0

Temperature Monitor

Temperature Monitor

Temperature Monitor

0V to 8V analog input

Temperature Monitor

Software driven 25 mA sink

Software driven 25 mA sink

Temperature Monitor

Software driven 25 mA sink

Fixed constant
12-bit
Fixed constant




= STCJ7:0] pins control: Fixed constant
= STCJ7:0] constant: 23

Click Ok.
Your MP7 system could look like:

CoreConsole - ARMT_ESC

File Yiew Actions Options Help
A
CoreMP7?
h SYSCLE RESETn RESETn
CoreMP7Eridge MEYSRESET!  Coremhibhivin SYSCLK CoredhbSram SYSCLK
RESETn
& LITAG
—# Ry _ICE_IF )|
3 & l RESETn |
; SYSCLE
RESETn
CoreAHBZAPE Sl
CaredPE  ME)g ? ?
RESETn RESETn RESETn
CoreAl SYSCLK CoreUARTaph SYSCLE | | coreUaRTapb_0t SYSCLK
=¥ analné siénal RS237_RAX A3PUART_RX
RSZ52_TH ASPUART TR W
Ls

You can observe the memory map by: View -> Memory map.



Memory Map

(i | |Z]

Memory Map for ARM7_ESC

CoreMP7_00

Base Address
CoreAHBLite 00:MoRemap CoreAHBLite 00:SwapSlotsandi

CoreAhbNvim_00 000000000 Ox10000000
CoreAhbSram_00 010000000 0x00000000

Coredl_00 Oxc0000000
CoreUARTaph_00 033000000
CorelUARTaph_01 035000000

top

[&

Select Generate Tab:

¢% CoreConsole - ARM7_ESC

File Yiew Actions Nelsise-M Help
Components | e |
HOL Selection
() Generate Veriog
@ Gengerate YHDL CoreMPT
License Selection
Configuration Errors i SYSLLE RESETn
Mo Errors Detected CoreMP7Eridge NIYSREZET!  Coreahbhvm SYSCLK CoreahbSram
RESETn
Generate Results o UTTAG
Progress Bars for Tasks =—(* R\ ICE If )|
el | | [ [ [ [ ][ | =coeusuclp '!'
<
RESETn
Save & Generate CorefHEZAPE SYSCLE
CoresPe M) ? i
RESETn RESETn
Coreal SYSCLK CoreUARTaph SYSCLE | | coreUsRTapb_ot
—s analoé siénal . R5232_RX
RS232_TX
A
< >




And click Save & Generate.
Now you can close the Core Console by File -> Exit

Note that question mark in Design Explorer changes into CoreConsole icon:

o Project Manager - C:Mctelprj\MP7_TutorialMP 7 _Tutorial. prj - [Project Flow]

@ Project  File Edit Wiew Tools ‘Window Help
FE@D & ik Gy ® [ Enable Designer Black creation
Current Designer view: |Impl1 ﬂ i3 @
Cresign Explorer L - X
A
Shiwa: |C0mp0nents j Design Entry Tools Root : Top
<1 il work _ -
o " ey = Pre-Synthe
+ @ BLACKBOX_PACKAGE [am_sywny &’j L Pt Post-Svnth
E HOL Editor | SmartDesign| CoreConzole | WiewDiraw oskoynines
=1~ Top (Top.vhd) Post-Layout
[E] &RM7_ESC il
B CLK_divd
‘ g .
i Source Files
(%] Hierarchy Files \
Catalog L o« x B Synthesis
Marne Filker: Funikion filker: 5. & Simulation
| * | #* Options Synplify M
4 Function, Mame l; new [Top.ed ¥ b adelSim v
-| ] Clock & Management | S 2
CCC - Dynamic = Project Flow
Clock - Delayed
Clock - Divided and Delaped *|Logk |* Librar | * Tope |4l | Find | Jptions ==
MU - Ma-Glitch hd
o |@Te._. Bleu. | [BMac ‘ E3 Reading file 'Tx_async.vhd' . -
Feading file 'Bx_sync.vhd' .
Inforrnation ifindows g x| A Reading file 'Rx_async.vhd'.

Feading file 'Clock gen.vhd'.

Project Manager New Features(®,
| g @ Feading file 'fifo 256x8 fusion.vhd'.

Properties @
File Path:
Civactelprj\MP?_Tutorialhhd\Top.vhd

Lihpasus el

Ready

< >
[» ]\ an 4 Ervors b warnings j Info j Find 1 f
YHOL |FAM: Fusion DIE: M7AFS600 PKG: 484 FEGA

Log indow

The sources are complete for physical design now, it is possible to synthetize, compile, place
& route and download it into flash, but first, we prepare the firmware.

There is Two Ways to create MP7 firmware Intel HEX file
=> In SoftConsole
= In Keil

We will use both ways, but, in this time (05. dec. 2007), we have under control generating the
hex file in KEIL and dubuging in RAM in SoftConsole only.

Run KEIL.

Create firmware folder in your ACTEL project directory



& Total Commander 7.02a - NOT REGISTERED (=3
et

& Ri@e K e e AH B M B

o] |Lnone_] 161 924 376 k of 195 358 400 k free \ .. [Ic] v |Lnone_] 161 924 376 k of 195 358 400 k free \
cVactelprhMP?_Tutorial\™ # v [GAy # v

Eiles Mark Commands Show  Configuration  Start Help

TName E xt Size Date At (TName E xt Size Date Al
&l.1 <DIR>  05.12.2007 07:45 | [T [Actel] <«DIR> 09.11.2007 10:55
[[J[component] <DIR>  04.12.2007 10:21 —| |7 [Actelprj] «DIR> 04122007 14:21 —
[J[constraint] <DIR> 04.12.2007 10:21 | |[J[Documents and Settings] <DIR> 23.08.2007 20:08
[J[coreconsole] <DIR>  04.12.2007 14:25 | |7 [flexim] <DIR> 08.11.2007 09:55
[T [designer] <DIR> 04.12.2007 10:21 ---||_J[Images] <DIR> 28.09.2007 11:21 -
ﬁ[filmwale] <DIR> 05.12.2007 07-4% ---| 2 [Program Files] <DIR> 04.12.2007 1616
[_J[hdi] <DIR>  04.12.2007 10:25 — | |_J[Program_Files_Embedded] «DIR> 0412 2007 15:49
[[J[package] <DIR>  05.12.2007 06:57 —| |7 [staff] «DIR> 23.08.2007 18:13 —
[_J[phy_synthesis] <DIR>  04.12.2007 10:21 —| | [SpnLM] <DIR> 04122007 09:32
[_J [simulation] <DIR>  05.12.2007 06:57 ---||_J[varchola] <DIR> 04.12.2007 08:38 -
[_JI[smartgen] <DIR>  05.12.2007 06:57 | |7 [WINDOWS] <«DIR> 05.12.2007 06:24 -
L3 [stimulus] <DIR> 04.12.2007 10:21 —||TJAUTODEXEC BAT 0 06.08.2007 14:45 -a-
[_J [synthesis] <DIR> 04.12.2007 10:21 —||[ | CONFIG 5Y5 0 06.08.2007 14:45 -a-
(O [viewdraw] <DIR>  05.12.2007 06:57 —| | [Z] kIZlog log 2 0412 2007 09:31 -a-
QMP?_Tutmial pri 18 203 05.12.2007 06:57 -a-
0k /17 kinD /1 files. 0 /13 dirlz] O0k/0kinD/ 3fles. 0 /11 dir[g]

c:Yactelpr\MP?_Tutonal> w

F3 Yiew F4 Edit F5 Copy FE Move F7 HewFolder F8 Delete Alt+F4 Exit

Open firmware directory and make subdirectories KEIL and SoftConsole in it.

Copy the source files (.c .h .1d .s) into KEIL subdirectory:



= Total Commander 7.02 I0T REGISTERED

Files Mark Commands Met Show Configuration  Stark

@ @i @y e e OO ER MBS B

2 184 19.03.2007 22:17 -a.
2 346 19.03.2007 22:17 -a.

(] debug_in_ram
[l run_from_nvm

Lnone_] 161 924 115 k of 195 358 400 k free - Lnone_] 161 924 116 k of 195 358 400 k free -
pitMP7_ KEIL\* = & <
TName Ext Size | Date At |Name TExt Size  Date At
L <DIR>  05.12.2007 07:47 || {& [..] <DIR>  05.12.2007 07:49 -
[] core_gpio c 1 822 22.03.2007 23:57 -a

[ core_uart_apb c 5179 19.03.2007 22:17 a

[ coreai c 17 974 24.11.2007 15:01 -a

[ esc07? c 2117 1.12.2007 12:06 -a

B uscr_io o 13 221 18.03.2007 22:17 a

D utility c 1 426 19.03.2007 22:17 -a.

D acm_defines h 3 243 26.03.2007 15:39 -a.

[] core_gpio h 728 22.03.2007 23:58 -a

[ core_uart_apb h 1 261 19.03.2007 22:17 a

[ coreai h 5 606 19.03.2007 22:17 a

[ corcai_regs h 7 415 19.03.2007 22:17 a

B corel rage h 488 22.03 2007 23:58 -a

[] coreuartapb_regs h 1 570 19.03.2007 22:17 -a

(] cpu_types h 413 19.03.2007 22:17 -a

D hw_macros h 3 707 19.03.2007 22:17 -a

[ platfom h 995 22.03.2007 23:53 a

[ quads_acm_cfg h 1 650 26.03.2007 07:43 a

[ user_io h 515 19.03.2007 22:17 -a

B utility h 2R7 1903 2007 272-17 -a

Id
Id

[ferto s 4382 19.03.2007 22:17 -a
[ vectais s 840 19.03.2007 22:17 -a
Total Commander
Capp 22 flsfs) to
Only fles of this type: [ g |
\ vl
[ Copy NTFS pemissions [may need administator rights]
[ [iT3 J[ reouewe ][ e | camd |
0k /0kin0/Ofiles 83k / 83k in 23 / 23 files
c:\varcholah-—= INSTAL =-\ACTEL MF7 files\MP7 source> v
F3 View F4 Edit F5 Copy F6 Move F7 NewFolder F8 Delete Alt+F4 Exit

In Keil toolbar menu choose Project -> New uVision Project



Create New Project

Saveir |3 KEIL

D

by Recent
Documents

s

Dezktop

=

)

ty Documents

by Computer

by Metwork File name:
Flaces

Save az type:

IMP‘?_firmware LJ Save
| Project Files [ uv2) | Cancel

Enter name of new project (MP7_firmware) and save it in
..\your actel project\firmware\KEIL

Next you will be promt to choose device. In latest version of KEIL (05. dec. 2007) there is no
option of MP7, so, you could to choose ARM -> ARM?7 (Little Endian)

Select Device for Target “Target 1° gl

CRU ]

Yendor:  ARM

Toolset:  ARM

Data baze

Device:  ARMT [Little Endian]

Description;

+-§® Aeroflex UTMC
+ @ Altim
+- @ fnalog Devices
+-§® AnchorChips
-G ARM
£ ARM7 [Big Endian)
ARM7 [Little Endian]

£3 Cortexb1
£3 Cortex3

|

£ ARMIBEE-S [Big End
£ ARMIBEE-S [Little En
£3 ARMYE-S (Big Endiar
£3 ARMIE-S [Litle Endic

X

~ ARMYTDMI-S based high-performance 32-bit RISC Microcantroller with Tk

W

[
|~

0K | Cancel Help




Click OK.

You will see:

K7 MP7_firmware - p¥ision3

File Edit Yiew Project Debug Flash Peripherals Tools SWCS Window Help

BEHE| ) BB (D [=E %% % Rl @ & e BRE 0 o0 m
COEE e K Target ez =
| Project Workspace - x|

=9 Target 1

BlElws e

LD

i

H

=

- =
ST T[] Build £ Command J Findin Files J el |»
Ready [ Simulation [ él

Now we prepare file structure in Project Workspace window.

Click twice slowly (not double-click) on Source Groupl to rename it. Enter new name:
Sources. Right click on Target 1 and choose New Group and name this group Headers. Make
further two groups ,,Linker Scripts* and ,,Start Up*.



K7 MP7_firmware - p¥ision3

File Edit Yiew Project Debug Flash Peripherals Tools SWCS Window Help
BEHG| 2B (D |=E 0% %% W el « » 1 | S| a|BE] O o P m
© e K K Target 1 RE SN
| Project Workspace - x|
Eﬁ Target 1
[0 Sources
[ Headers
[ Linker Scripts
b (77 StartUp
E|@|w |
x s
» -
i
Z
E
& -
ST T[] Build £ Command J Findin Files J Ll 1]
Ready [ Simulation [ él

With double click on each you can add files. Add to:
Sources group all .c files

Headers group all .h files

Linker Scripts group all .1d files

Start Up group all .s files

You will be promt about file type for .1d files, choose Text Documentation:

Get Filetype for *debug _in_ram.ld

File: QF.
Mdebug_in_ram.ld Cancel |
Type

So now you could see:



E MPT_firmware - pVision3

File Edit Wiew Project Debug Flash Peripherals Tools S¥CS  Window Help

DeHF| R[S EE %D % G ~[aa] #
-+ & a 0 gy 107
e X K Target Claz®

“F‘mject Workspace - x|

EE=

-£5 Sources

; ukility.c
care_gpio.c
core_uark_apb.c
cobeai.c
escl7.c
user_io.c
[#-[77] Headers

[=1-E5 Linker Scripts
debug_in_ram.ld
run_from_nvm.|d
[=1-E5 Skart Up

: veckars.s

¥ atl.s

B[E @ %

.1
L[]

i

as

C

£

‘g_ -

A1« r[# ] Build & Command i Find in Files [ |14 |»
JReady [ |Sirnulation [ jJ

Keil provides option to create more ,,Targets* with various settings e.g. for Debuging in RAM
or Run from FLASH settings. We create two targets instead Target 1: debug_in ram and
run_from nvm according to names of linker scripts.

Choose from Toolbar menu: Project -> Manage -> Environments, Components, Books...
Select Project Components Tab

You will see:



Components, Environment and Books

Project Components lFDIders.-"E:-:tensiu:uns] Bu:u:uks]
Froject Targets: 273 | % | 4 | & | | Groups: | 2| | |Files: P S
Sources utility. &
Headers CoMe_gpio.c
Linker Scriptz core_uart_apb.c
Start Up Coreal.c
ezcl?i.c
LEEr_in.c
Set az Current T arget | Add Files |
] | Cancel Help

X

In Project Targets, double click on Target 1 to rename it into Debug in RAM. Then click onto
leftmost icon: new(insert) to create new Target: Run from NVM.



Components, Environment and Books

X

Froject Components lFDIders.-"E:-:tensiu:uns] Bu:u:uks]
Froject Targets: 273 | % | 4 | & | | Groups: | 2| | |Files: P S
Debui ifn Rk Sources Litiliby,
Headers CoMe_gpio.c
Linker Scriptz core_uart_apb.c
Start Up Coreal.c
ezcl?i.c
LEEr_in.c
Set az Current T arget | Add Files |
] | Cancel Help

Click OK.

Now, set make the same settings for Debug in RAM:
Project -> Options for Target ,,Debug in RAM*



Options for Target ‘Debug in RAM'

Device l Target] Dutput] Listing] |Jzer ] CC ] .-’-'-.sseml:uler] Linker] Del:uug] thilities]

[atabase: | J

Yendor ARM
Device: ARMY [Little Endian]
Toolzet: ARM

+ @ Aeroflex UTMC # |ARMYTDRI-S bazed high-performance 32-bit BISC Microcontraller with Th
< g Altium -
+ @ Analog Devices
+ - AnchorChips 0
- ARM
£3 ARM?7 [Big Endian)
AR [Little Endian)

£3 ARMIEEE-S [Big Endiz
£3 ARMIEEE-S [Little End
£3 ARMIE-S [Big Endian
£3 ARMIE-S [Little Endiar
£3 Cortew-d1

£1 Cortextd3
& AC1Y Flactramics Carmarabic
s < >

| &

] | Cancel D efaultz Help

Options for Target ‘Debug in RAM'

Device Target l Dutput] Listing] |dzer ] CC ] .-’-'-.sseml:uler] Linker] Del:uug] thilities]
AR ARKYT [Little Endian)

wral [MHz]; [125

Operating system: | Maone ﬂ

(] | Cancel Defaultz Help




Options for Target ‘Debug in RAM'

Device] Target  Output l Listing] |Jzer ] CC ] .-’-'-.sseml:uler] Linker] Del:uug] thilities]

| Select Folder for Dbjects. .. | Mame of Executable; |MP?_H"TIW~3TE

* Create Executable: S\MPY_firmware

Iv Diebug Information

[ Big Endian

" Create Librany: SbMP?_firmware. a

[ Create Batch File

] Cancel D efaultz

Options for Target ‘Debug in RAM'

Device] Target] Dutput] Listing] |dzer ] CC ] fssembler  Linker lDeI:uug] thilities]

Temt Start: |
[ Enable Garbage Collection

[v Do not use Standard Spstem Startup Files Lz Siat |

W Donotuze Standard Svstern Libraries B35 Start; |
[ Usze Math Libraries

Linker Script |.'xu:|e|::ug_in_ram.lu:|
File:

Edit..

Inciude |
Librariez

Include |
Pathz

.

Mizc:
controls

Linker |-mthumb-intensork, 2w -0 MP7_firmware. elf

sontral | o -nostartfiles -nodefaultib:
ztnng

(] Cancel Defaultz

Help




Options for Target ‘Debug in RAM'

* Usze Simulator
[ Limit Speed to Beal-Time

[v Load Application at Startup
Initialization Fils:

Device] Target] Dutput] Listing] |Jzer ] CC ] .-’-'-.sseml:uler] Linker Debug l thilities]

Settings || T Use: |L|LINK ARM Debugger

[v Bur ta mainf)

Reztore Debug Seszion Settings

o] e |

[v Load Application at Startup
|nitialization File:

Resztore Debug Seszion Settings

ﬂ Settings

[v Breakpoints [v Toolboz [v Breakpoints [v Toolbox

[v *watchpoints & PA [v *#fatchpoints

[v Memomy Dizplay [v Mermary Display
CPI DLL: Parameter: Drriver DLL: Parameter:
SARM.DLL SAaRM.OLL
Diialog DILL: Parameter: [rialog DILL: FParameter:
DARMP.DLL |mHMP.DLL |

] | Cancel | D efaultz | Help

Make the same settings for Run from NVM, instead Linker, where browse the

Arun_from_nvm.ld



Options for Target ‘Run from NVM'

Inciude
Librariez

Include
Pathz

Mizc
controls

Linker
control
ztring

[ Enable Garbage Collection

[v Do not use Standard Spstem Startup Files

[+ Do not uze Standard System Libranes
[ Use Math Libraries

Device] Target] Dutput] Listing] |Jzer ] CC ] Azsembler  Linker lDeI:uug] thilities]

Text Start: |

Data Start: |

BSS Stat: |

Linker Script |.'xrun_frn:|m_nvm.ld
File:

| Ede

.

-mthumb-intensork, A -0 MPY_firmware. elf
* o -hogtartfiles -nodefaultibs

k. | Cancel

D efaultz

Help

Build the project by:
Project -> Rebuild all target files...

Asigning the Intel HEX file into Libero project:

In LIBERO Catalog expand the Fusion peripherals and choose the Flash Memory System

Builder.



o Project Manager - C:Mctelprj\MP7_TutorialMP 7 _Tutorial. prj - [Project Flow] g
x

9 Project  File Edit Wiew Tools ‘Window Help - &
FE@D & ik Gy ® [ Enable Designer Black creation
Current Designer view: |Impl1 ﬂ i3 @
Cresign Explorer L - X
Shiwa: |C0mp0nents j Design Entry Tools Root : Top »/
<1 il work = = = = - -
o " ey = Pre-Synthe
+ @ BLACKBOX_PACKAGE [am_sywny u L Pt Post-Svnth
< I;l=:l Top [Top.vhd) HOL Editor | SmartDesign| CoreConzole | WiewDiraw oskoynines
He B > 4 Post-Layout
4| | ’ e
i Source Files
(%] Hierarchy Files .
Catalog L o« x B Synthesis
= o .
Marne Filker: Funikion filker: 5. Simulation
| * | #* Options Synplify M
4 Function, Mame l; new [Top.ed ¥ b adelSim v
- ﬁ Fusion Penpherals | S 2
Analog Spstem Builder e Project Flow
Flazh Memory System Builder
Dcillator - Crystal | | ook [* Librar | * Tope |4l | Find | Jptions ==
1 | W[
Bc... |@ Te.. ElBU--- El-"-c--- ‘ = Reading file 'Bx_sync.vhd' . A~
Feading file 'Bx_asyhnc.vhd'.
Inforrnation Windowe §oe x| A Reading file 'Clock_gen.vhd'.

Feading file 'fifo 256x8 fusion.vhd'.

Project Manager New Features@ Reading file 'Top.vhd’

F‘rupenies @ é The MP7_Tutorial project was opened.
Yendor: Actel é "
Library: SmartGen - -
Name: FlashMemorySystemBuilder 3 k) | P\"‘“ f‘; Errars }‘. Warnings ?\IHFD «)\F""dl f’r
Ready WHDL FAM: Fusion |DIE: M7AFSG00 PKG: 454 FEGA

You will see:



Flash Memory System: Create core

Awailable client types

Clients uzed in the Flash Memory Spstem

£

Analog System
| nitialization

Client Type Client Hame

Start
Address
{hex)

Word
Size

Page

Intialization

Lock Start

Start

End

Order Cost

Address

RAM Initialization
CFl Data

Add to System. ..

™ Pipelined Read

Help

Ready

Cloze

4.

Click on the Data Storage

Client name: |MF'?‘_FIF|MW¢«FIE

Size of word: a | bitz

MHumber of words; 3192

Start address: 0 _|:| [hexadecimal anly]

Format of memaory content file: | |ntel-Hex

JTAG Protection

[ Prevent read [ Prevent write

Help

=

OF.

Mernom cantent file: |E:"-.-“-‘-.ctelpri'\MF'?_Tutnrial'\firmware'\KEIL'\M F7_firnware. bies

Cancel

and full the dialogue window as follows:




Into Memory content file browse the .hex file, which was generated by KEIL.

Click OK.

Flash Memory System: Create core™

ole| x|

Awailable client types

Analog System

| nitialization
Diata Storage
Ré&M Initishization
CFl Data

[z

™ Pipelined Read

Help

Ready

Clients uzed in the Flash Memory Spstem

Start L
Word Page Intialization
Client Type Client Hame Address S?zrt(a
(hex} Start End Order Cost
1 ©|osta Storage MPT_FIRMMARE 0 8 0 63 HiA, N,

Generate...

_ Gorete.|
Close

Click genrate.



Generate Core

X

Configured cores:

ARM7_ESC
CLE_dive
MP7_FIRMWARE

Caore name:

Cukput Format: J

Help | Ik | Cancel

Write Core name and click OK
Click Close

Now you can see in LIBERO Design Explorer MP7 FIRMWARE component:



o Project Manager - C:Mctelprj\MP7_TutorialMP 7 _Tutorial. prj - [Project Flow]
9 Project  File Edit Wiew Tools ‘Window Help

Lihpasus el

Ready

FE@D & ik Gy ® [ Enable Designer Black creation
Current Designer view: |Impl1 ﬂ i3 @
Cresign Explorer L - X
A
Shiwa: |C0mp0nents j Design Entry Tools Root : Top
<1 il work _ -
o " ey = Pre-Synthe
+ @ BLACKBOX_PACKAGE [am_sywny u L Pt Post-Svnth
E MF7_FIRMWARE HOL Editor | SmartDesign| CoreConzole | WiewDiraw oskoynines
Post-Layout
+1-E Top (Top.vhd) il
4| | ’ e
i Source Files
[E] Hierarchy Files
= .
Catalog p ~x Synthesis
= o .
Marne Filker: Funikion filker: 5. Slmul_allon
| * | #* Options Synplify M
2 Function, Name l; new [Top.ed ¥ ModelSirn bt
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Inforrnation ifindows g X | A Reading file 'MP7_FIRMWARE.wvhd'.
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| g @ Please refer to log file at C:/Actelprj/MNP7 Tutorial/smart
Properties @ § o
File Path: = ¢ 3
i, NMP7_FIRMWARE whd B an § Ervors § warnings } Info f Find 1

YHDL |FaM; Fusion |DIE: M7AFSA00 PEG: 454 FBGA

Click on the Synthesis button.
The Synplify starts:




Synplify 8.8BA1 - Apr 16 2007 - [C:\ctelprj\MP7_Tutorial\lsynthesis\Top_syn.prj]

Pt H =2 £ e

Synplify’

Source Files

Add C:\ActelprisMPT_Tutariahsynthesis | spnthesis Type Modified
-I-6=§ Top_syn [project) 5] stdout.log log 19.26:48 OF
ch +-[Z] WHDL
ange pilE synthesiz (Top)
Edit
4 »

Fesult File
Change | Top.edn

Target
Change | Actel Fusion : MPAFSEDD -1, run_prop_extract, maxfan: 12, globalthreshold: 50,

U Vowios| Ready ...

Cancel ‘

Synplicity

Frequency (MHz)

100 EI:
Symbolic FSM Cormpiler

FResaource Sharing

v
v

@ Top_syn.pri

MUM

Click RUN button to synthetize your design
After synthetize the should not be any errors. Some warnings are OK...

Synthetize icon in Libero should be green:




2 Project Manager - C:Mectelprj\MP7_Tutorial\MP7_Tutorial. prj - [Project Flow]
- X

9 Project  File Edit Wiew Tools ‘Window Help

REEDE ik Gy ® | Enable Designer Block creation

Current Designer view: |Impl1 ﬂ i3 @
Cresign Explorer L - X
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Properties @ § o
File Path: = ¢ 3
CivactelprisMP?_TutorialshdNTop.whd ki | P\MI lpﬂ Errars }‘\ Warnings }\Infn }\Findl f

YHDL |FaM; Fusion |DIE: M7AFSA00 PEG: 454 FBGA

Lihpasus el

Ready

Now continue with Place and route. Click on this icon:



o Project Manager - C:\ActzlprjiMP7_Tutoria\MP7_Tutorial. prj - [Project Flow]
%3 project Fle Edt Wew Icols Window Help
@b

Curent Cesigner view: |Impll -
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Eweneory ]
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3 Function, Name [-]
+ . DSP
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CoreConzole

WiewDraw

Pre-Synthesis
= Post-Synthesis
Fost-Layout
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HDL Editar | SmartDesign

Infarmation Window L -x

Project Manager New Features @
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Properties
File Path:
Ci\ActelprisMP7_Tutarial\hdlTap vhd
Library: werk

Created: Tue Dec 04 20:25:35 200
Last Modified: Tue Dec 04 _0:25:35 200
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=

Source Files l

i Simulation
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M
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whaveFormer

F

i |

Past-Synthesis
Files

Stimulus Editar

EplacekRoute
Designer

new (Top.adl =

=1
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" Project MMow

x

Lokfor; | * Lbrary, | * Type: |l

Find

Options

Ready

x

Log Widow

SDC Import: Starting final constraints validation...

Ihe Cowplle command succeeded [ UUUU:zU )

<

All f Errors }, Warnings ) Info \ Find 1

WHOL FAM: Fusicn DIE: M7PAFSE00 PKE: 484 FEGA

Make sure that you will see:

Organize Constraints for Designer

Click to zelect a constraint file in the project, and use the Add buttan to pags the file o
‘dezignertimpll T op.adb’.

|lze the Remove button to remowve constraint files from Dezigner.

Ilze the Up/Down arrow buttons to zpecify the order of the constraint files in Designer.

EAR2

3

Constraintz filez in the project:

| Crigin | Constraint files for Designer:

| Crrigin |

Top_sdc.zdc

#+= Bemove

=
&
Ll

Designer anly supportz 2dc and pde az zource files.
[v Shaow thiz dialog before creating a new adb.

Help | ] 4 | Cancel

Synplfy

Desinger starts...

Proceed with these settings:



Device Selection Wizard

Eamily: Fusian
Diie Package

AFS090 208 POFP

AFS 250 286 FEGA
AFSE00 484 FEGA

M 7AFSEON

M1AFSEOD

AFS1500

Speed: Die waltage:

E - 15

Cancel | Hest » |

Device Selection Wizard - Variations

Rezere Ping
[+
[+
[+

140 Attributes

Default [0 gtandard: LWTTL -

Pleaze uze the 140 Attribute Editor o
FinEditor to change individual [/0 attributes.

Cancel < Back | Mest = |

Help




Device Selection Wizard - Operating Conditions

Junction Temperature [in dearees Celsiusz)
Bange: Best: Typical: Worst:
Er—-] 25 &
Yaoltage [in voltz]

Rarge: Best: Tupical: ‘wiorat:
|EEIM j 1.575 15 1.425
Cancel < Back | Finizh | Help

Desinger:




4 Designer - [Top] = E
@ File Yiew Tools Options Help - a8 x

DB 2| BIESE | =g Es

| Design Flow

)

= ST — LA
*@ i* gﬁ Back-Annotate
Compile * ° Layout * . ;% .;D

Programming File

L[]

MultiView Navigator SmartTime
- 9 || 1
L% ; 2
B (=l D
&

:"iitx:: PinEditor ChipPlanner HDE?IEtt':E"le Cngzti:::lts
x| ~
i |

The Import command succeeded ( 00:00:08 )
Design saved to file Top.adb.

The Execute Script comcand succeeded [ 00:01:16 )
Checking for software updates...

o Info: This software wersion is up to date. There are no available up

< >
| |"‘\AII ﬂ' Errars .}\ Warnings l}\lnfo f

Ready FarM: Fusion DIE: MPAF3600 PKG: 434 FEGA

I tis necessary to import pin assigement file. Copy the Top.pdc file into Constraint folder. By
File -> Import Source Files:



X

Import Source Files

Mate: the relative order of the zame type of files iz impartant.
“When imparting multiple EDIF or YHDL files, the top-level file must be lagt [at the bottom].
I1ze the Up and Down buttons to specify the relative order of the files.

Source Files Type | L Add.

1 |C:'l.ﬂ-.cteIprj'l.ru1P?_Tmnrialﬁ.synthesis'ﬂnp.edn edn

2 CogctelprhdPT _Tutariahcoreconsolelcommonis 7 Sih7 AFSE00-21 | ook Fdodify. ..
3 CasctelprphPy _Tutoriahsyrthesiz\Top_sdc.sdo zdc

4 Delete
5

] Copy lozally
7

8 e
9

; g
-

—
Awdit timestamp: wWed Dec 05 19:33:08 2007 Audit options. . |

Help k., Cancel
L |

Click Add button and browse the Top.pdc file. Then two times the OK button. Hit Compile
button. In dialogue window click OK. If everything is OK, Compile button colors green.
Click on layout button and accept the default settings.



% Designer - [Top*] |rg|
-8 %

5] Fle Wiew Tools Options Help

D@ 2| ZE D& o] 25

Jas

3

0

| Design Flow

» Back-Annotate
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Programimin g File

Multiview Mavigator SmartTime
| 11 |
LB 7 ;
@@ & v, EHo s
Netlist A A A I/0 Attribute Constraints
Viewer PinEditor ChipPlanner Editor Editor
x| o -0-0-0-0-a0a ~
_I —_—
Loading the Timing data for the design.
Finished loading the Timing data.
TIMEER: Max delay timing regquirewments have been met.
The Layout command succeeded ([ 00:03:45 )
v
4 | d
| [\MI ."{. Errors }'\ S arnings l,:‘\'Info l.l'r
Ready F&M: Fusion |DIE: M7AFSE00 PKG: 484 FEGA

Create programming file with click on Programming File

Make selections:

FlashPoint - Programming File Generator - Step 1 of 1

Silicon Featurels) to be programmed:

[v FPGA Array

[ FlashromM

Ermbedded Flash Memory Blacks (EFME]):

Block Block . - .
Program Name o Fo Original Configuration File
14 | ¥ |&RM7 _instiCores 1 Madify...
I/ stake during programming: Tri-State ﬂ

Help | Finish |

Cancel

And click on the modify button




Then on the Import configuration file:
Modify Embedded Flash Memory Block r5__<|

Block name: ARMF_instfCoreahbhivm_00}Coreahbhym_TOIL
Block location: 1
Block configuration file: CilActelpriMP?_TutorialismartgeniMP7_FIRMWAREVMPZ _FIRMW, | "import Configuration Fils,
Block content:
Select All Clients Unselect Al Clients
Start Client JTAG Protection
Program | Client Type | Client Hame Address N Prevent Prevent Original Memory Content File
depthXwidth N
{hex) Read Write
1 Ird Data Storage  MPY_FIRMWARE 1] 819248 ' ' ChsctelpritP? _Tutarialfirmwarei Import contert...

Help OF | Cancel |

And browse the location ...\project dir\smartgen\MP7 FIMWARE\MP7 FIRMWARE .efc
Click finish and name flash configuration file as fpga flash nvm_flash

nd check stapl file:

Save |l.f} irmpl1 j IfF -

- =) sirmulakion
ﬁ |5 Top. dtf
My Recent adal2764-4,tmp
Documents :_} afl

T af1.ufec
afz.efel

E] desigrner_genhdl

. [ Top

‘-.) Top.ide_des
Top.lak

ty Documents Toptel

3

by Computer

My Metwork.  File name: |fpga_flash_nvm_flash j Save |

Flaces
Sawve az type(z] v Programming Data [ pdb) v STAPL .=tpf Cancel

N

Desktop

Click Save

In desinger Save projcet and exit it



Now, you will download the configuration file into Fusion device. Run the programming with
FlashPro

Create new project

X

New Project

Project Mame:

| P'ru:ugrammer|

Project Locakion:
| CihAckelpriyMP? _Tutorialidesigner! Browse. ..

Programming mode

* Single device
" Chain

Ik | Cancel Help

Click OK.

Click Configure device

1 FlashPro - [Programmer]

File Edit Yiew Tools Programmers Configuration Customize Help

Dl ? (@D m% EE s

ﬁj Configure Device

=»

Open Project Dﬂ Wiew Programmers

Programming File

Mo programming file loaded Browse. .,

Programming File information:

PDE Configuration. ..

Single Device Configuration Window

Software Version: ©.0.4.1

Driver : 2.0.4 build 2

programnsr ' 04404' @ FlashProld

Created new project 'C:\ActelpriZMP7_Tutorialldesigner' impll)Prograwer’ Prograwaner . pro’

L x

| [\AII A Errors }\' \Warnings l}\‘Inl’o l/r
Ready no programming file loaded |SINGLE




And Browse programming file:

Load Programming File

by Recent
Documents

=
@
Desktop

3

by Documents

39

by Computer

-

ey M etwarl,
Places

Look jr: | =2 impl1

& o EE-

|3 Programmer
| == simulation

|5 Top.dtf

fpga_flash_reem_Flash,stp

File narme:

Filez of bpe:

|fpga_flash_n\.fm_flash

|.-’-‘-.II Pragramring Files [*.pdb; * ztp]

Open |
Cancel

Click OK.



FlashPro - [Programmer.

File Edit

DEE 7 |0 |+=%

Wiews Tools Programmers Configuration Customize Help

EHE %

=

Dﬂ‘

Open Project

Configure Device

PROGRAM

=

Wiew Programmers

Programming file
fpga_flash_rvm_flash.stp

Programming File infarmation:

Erowse. ..

DATE MOLIFIED Wed Dec 05 19:49:0% Z007 Pl .
STAPL FILE NAME C:\hctelpriiMP? Tutorialidesigmeriimpllyf Mode: @ Basic  Advanced
CREATOR Designer Wersion: 2.0.4.1
DEVICE M7AFSE00
PACHKAGE M7AFSE00-FG484 .
DATE 2007/12,/05 Action
STAPL_VERSION JESD7L
= o
IDCODE 033E61CF * PROGRAM
z| |pESIGH Top " VERIFY
B|| |cHECKsUM 6781
[=4
z SECURITY ENCEYPT FROM CORE HVM 1 " ERASE
5| |aLe_VERSION 15
g SILSIG oooogoao
2| |max_FREQ Z0000000 v
é < ¥
i)
3
= Chain Parameter... PDE Configuration. ..
g=]
=
i
| programmer ' 04404" FlashPro3i
e Created new project 'C:h\ActelpriiMP7_Tutorial)designer’ impli’ Programwer’ Programmer . pro'
STAPL file 'C:\ActelpriZMP7 Tutorialidesigner)implldfpgs flash nvm flash.stp' has been loaded successfully.
DESIGH Top: CHECESUM a781; ALG_VER3IION 15
| [\.IAII .'" Errors ;’\ ‘Warnings ;’\Info l.-'r
Ready C:hactelpritMP7 _Tutorialidesigneriimpllifpga_flash_nvm_flash.stp [SINGLE

Click Program.




